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1.2

Overview

Introduction

SDI FTP is a Windows-based FTP client application that transfers files between any host system
running an FTP server and your PC.

Witidows PC

Wéﬂ/

)
% Sl;.r-{'rr;r
%.

Host Computer

With a familiar Windows Explorer-like interface, SDI FTP is easy to use for the novice, yet packed full
of features for the more advanced user. Designed specifically Windows, SDI FTP supports Windows
Windows 11, 10, 8, 7, XP and Windows Server 2022, 2019, 2016, 2012, 2008, 2003 and 2000.

Features

Standard Features

Host Support:

Explorer-like Interface:

Folder Management:
Drag/Drop Support:

Address Book:

Activity Log Files:

SDI FTP can connect to a wide variety of host operating systems,
including: Windows, UNIX, VMS, 0S/2, z/VM, z/0OS, VSE/ESA and
0S/400.

A familiar Windows Explorer-like interface shows folder and file views
for both the local and remote computers. See Windows and Panes.

Create, rename and delete local and remote files and folders.
Drag and drop files to upload or download.

Save connection details for all your favorite FTP sites in the address
book for quick easy access.

Log files keep a record of your file transfer sessions. (View, Log Files)

Multiple Simultaneous Connections: A sleek tabbed window allows you to manage up to

Proxy/Firewall Support:

File Filters:

Synchronize:

10 simultaneous connections. See Working with Sessions.

Customize SDI FTP to work with your proxy server or firewall. (Host,
Properties, Firewall tab)

Use the file filter wildcards to display specific groups of files in the
host and/or local file panes. (Host, Properties, options tab)

(New!) Synchronize local and remote folders with a single click. (View,
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Synchronize)

Transfer Resume: Resume incomplete file transfers where they left off instead of starting
the file transfer over.

Scripting Language: Use the scripting language to automate common operations.

Command Line Operation: Allows common operations to be built into command line
batch files.

Queued File Transfer: Display a real-time progress bar or transfer files quietly in the

background. (Host, Properties, Download tab and Upload tab)
Automated Installation:  An installation wizard leads you through install and uninstall.

Optional Features

SSL Support: SSL (Secure Sockets Layer) allows you to establish a secure
connection between SDI FTP and a host computer. Protect your
confidential data from eavesdropping and tampering!

Protocols: SSLv2,SSLv3, TLSv1
Encryption Strength: 256-bit

SDI FTP SSL support includes software developed by the OpenSSL project for the OpenSSL
toolkit. This feature includes cryptographic software written by Eric Young. This feature includes
software written by Tim Hudson. (See the OpenSSL license agreement)

1.3 Evaluation and License Agreements

Evaluation

SDI FTP is distributed as an evaluation version for a 30 day trial. The evaluation version includes all
the product features. After the 30-day evaluation period, you must register the product with SDI if you
wish to continue using the product. When you register the product, you also select the optional
features you desire.

License Agreement

By registering for and/or ordering SDI FTP, by whatever means, you agree to be bound by the terms
and conditions of the Licensing Agreement set out at http://sdisw.com/license.htm.

1.4  Maintenance and Technical Support Agreements

Maintenance and Technical Support Agreements

You can find the maintenance and technical support agreements on the following web page:
http://sdisw.com/maintenance.htm.

Please refer to the License Agreement for SDI's exclusive terms and conditions of use and sale.

1.5 Copyright and Legal Notices

SDI FTP SSL utilizes the "OpenSSL toolkit" functionality provided by "The Open SSL Project” at
http://www.openssl.org. SDI Limited acknowledges all patent rights therein."
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The OpenSSL toolkit is licensed under a dual-license (the OpenSSL license and the original SSLeay
license). See the license text below.

OpenSSL License

Copyright (c) 1998-2000 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: This product includes software developed by the OpenSSL Project for use
in the OpenSSL Toolkit. (http://www.openssl|.org)

4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact openssl-core@openssl.org

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear
in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (
http://www.openssl.org)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT TAS IS" AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tih@cryptsoft.com).

SSlLeay license

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscapes SSL. This library is free for commercial
and non-commercial use as long as the following conditions are aheared to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL
code. The SSL documentation included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution as the author of the parts of
the library used. This can be in the form of a textual message at program startup or in documentation
(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)". The word 'cryptographic’ can be left out if the rouines from the library
being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement: "This product includes software
written by Tim Hudson (tih@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG TAS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot
be changed. i.e. this code cannot simply be copied and put under another distribution licence including
the GNU Public Licence.

1.6  Support/Questions/Suggestions

The best way to contact SDI about support or with questions or suggestions is to send an e-mail
message to support@sdisw.com.

Please include the following information with any support request:
1. What version of Windows you are running.

2. What version of SDI FTP you are running. Select About SDI FTP... from the Help menu to get
the SDI FTP version number and build date.

3. Can the problem be recreated? If so, how?
Include the full text of any dialog or message boxes that appear when the problem occurs.
5.  Your telephone number and e-mail address.

SDI welcomes any questions about SDI FTP and we will do our best to answer those questions in a
timely manner.

SDI would also like your input about possible enhancements to SDI FTP. We are interested in anything
that will make SDI FTP easier to use, more efficient or more effective. Many of the product's features
came from suggestions from early users of the product.

We are also looking for new product ideas and if you have an idea for a Windows product that you
want developed please let us know.

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.


mailto:tjh@cryptsoft.com
mailto:support@sdisw.com

5 SDI FTP User Guide

2 Getting Started

2.1  Connecting for the First Time

To get started with SDI FTP, you need to create a session and connect to a host computer. Once you
are connected to the host computer, you can move files between folders on your PC and folders on the
host computer just like you move files between folders on your PC.

1. Open the Host menu and select the New command or click the New button m on the toolbar.

Edit Action View Help

B few  CirleN gl
= I '
i} Conmect

£

2. Fillin the New Session Setup dialog box. Here a few hints to get you started.

(Comnectta Hea - SUFTP
Srrmor b
18l PC Comparey
Bt Mgve
Fpi o b 2o
ETP Pt Vot T
Fi] L=

=

Session Name

Host Name

FTP Port
Host Type

User Name

Password

Enter a descriptive name for your session. This session will contain all
the settings you need to connect to a specific host. If want to connect
to more that one host computer you will create multiple sessions. The
session name is used to select a tailored session for future
connections. Here are some examples: (Microsoft, IBM, Mainframe
Site 1, AS/400 FTP Server).

Enter the domain name or IP address of the computer you want to
connect to. If you do not know the domain name or IP address, you
will have to contact the network administrator at the host computer
site. SDI cannot provide you with that information.

Enter the FTP connection port number. This is usually 21.

Specify the operating system running on the host computer. Specify
"Automatic detect" and SDI FTP sends the SYST command to the
host computer to determine the operating system. This is the
preferred selection. If the host computer, rejects the SYST command,
select the appropriate host operating system from the list.

Enter your user name. If you are connecting to an FTP server that
allows anonymous connections, check the "Anonymous" check box
and SDI FTP will fill in a user name of anonymous for you.

Enter your password. If this is an anonymous connection, most FTP
server administrators request that you fill in your e-mail address as
the password. If you wish to be prompted for your password, check
the "Prompt" check box. If you want you password to be saved so that
you do not need to reenter it each time you connect to the host, click
the "Save Password" check box. The password will be encrypted and
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saved with the other session information.

3. Thisis all you need for connecting to most FTP servers. Click the Connect button to make the
connection.

2.2

The SDI FTP workspace is divided into several different bars and panes.

Windows and Panes

Menu Tip 500 Webs Site [cenmecied] - 50| FTP
Hgst Ede Ation Yew e
Toolkar QUS| 5# || rEe] K0S > |. | 8|0 |6 4]« |58 o it [
Toaiers o SCBTL AL 9% Roocal] YT e —
Local tree Bredhe WAEH 1) e | Retmate
o g pechive ) v ) e
pane o VAR (P 0 gbte tree pane
Wt b . JFile Fitter=
e VD () "4
v g Bpinceatis Dk, (1) ]
¥ gk Bl ()
Serterks A T * e [
g e | Trpe I 5w | Typa [ Modfd | &
Local list = G = .| P Pk BT Remaote list
) Do Pl Fokde LRI L prate Fie Folder  ITINED..
JrAne b _E Bl Fokkr LN o b Fie Fokder 260N .. [Ene
Inev_F Pl Fokdr (2RI L3 o Fie Folder  ITNOML ...
Sty Pl Fikder b Fie Folder  2GMEROL .
Output |I:Ig LIEY s Ty LJsgrbn Pis Folder  ZTAOZ0N ..
pane i Pl Fokder = Bl Folder O ..
ST -
= VED Dperareg ASTH aade dali corrmtan b /ndh
Session o e p——
tahs i e e {ovvmion 3, Saemon 34 Ewimon & ) Gmason s ) Sevson & ) Savson 1 Savsn 8 ) e ¢ || 1 |
esdy Rewat fotn
|5‘tatus har |.~f
Menu

The menu bar gives you access to the SDI FTP commands.

Toolbar

The toolbar offers one-click shortcuts to commonly used commands.

Local Tree Pane (top left)

The pane at the top left shows the drives and folders on the local computer. The information is
presented in a "tree" form, similar to the left-hand pane in Windows Explorer. Initially, the tree is
shown with all branches in a "collapsed" state. A branch may be expanded by clicking on the "+"
symbol next to the branch, or by selecting the branch and pressing the "+" key on the numeric keypad.
A branch can be collapsed by clicking on the "-" symbol, or by pressing the "-" key on the numeric
keypad. If a folder is selected, it becomes the current folder for the active session. The local folder
tree pane is simply a tool for navigating folders, all the manipulation of files and folders is done in the
local list pane.

Local List Pane (bottom left)

The pane at the bottom left shows the folders and files present in the currently selected folder on the
local computer. The information is presented in a "list" form, similar to the right-hand pane in Windows
Explorer. The listis initially displayed sorted in ascending order by file name. The list can be resorted
in ascending or descending order, by file name, size, type or date by clicking on the column heading.
Additionally, the list can be shown in one of four formats: as large icons, small icons, as a list view or
as a detailed view (default).

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.
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A single folder or file can be selected from the list by clicking on the item or by using the up and down
arrow keys on the keyboard. Multiple folders and files can be selected from the list by clicking on each
item while holding down the Ctrl key on the keyboard, or by holding down the Ctrl key while using the
up and down arrows on the keyboard and pressing the space bar. A folder can be opened by
double-clicking the item with the mouse.

Remote Tree Pane (top right)

Once connected to a remote host, the pane at the top right shows the folders on the remote computer.
Branches may be expanded and collapsed as with the Local Tree Pane (see above). The remote tree
pane is simply a tool for navigating folders, all the manipulation of files and folders is done in the
remote list pane.

Remote List Pane (bottom right)

This shows the contents of the currently selected folder on the remote host. The list can be sorted and
items selected in the same manner as described for the Local List Pane (see above).

File Filters

The local and remote list panes each contain a file filter edit box. Use the file filter to display a subset
of the files and folders contaned in the current folder.

Output Log Pane

Immediately below the four folder and file panes appears the Output Log pane. This can be hidden or
made visible by selecting Output Log from the View menu. The Output Log pane shows the FTP
commands and responses to and from the host computer for the currently active session. Each line
appears in a different color as follows:

Green FTP commands sent to the remote host

Blue  Normal responses and messages received from the remote host
Red Error messages received from the remote host

Black Status or informational messages generated by SDI FTP

Session Tabs

Session tabs allow you to switch back and forth between multiple FTP sessions.

Status Bar

The status bar indicates sessions settings and session status. The status bar can be hidden or made
visible by selecting Status Bar from the View menu.

Working with Sessions

A "session" is a file on disk containing all the information necessary to connect to a host computer and
defining the options in use when connected to that host. Up to ten sessions can be active
simultaneously.

Opening a session

You can create a new session or open an existing session by using the New Session Setup dialog box.

Opening Multiple Sessions

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.
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You can open up to ten session at the same time. For example if you wanted to connect to the IBM
and Intel FTP servers as the same time:

1. Create sessions for IBM and Intel. (Host, New)

2. Connect the IBM session. (Host, Connect, Session Name = IBM, Connect button). The IBM
session is assigned to the first session tab.

3. Connect the Intel session. (Host, Connect, Session Name = IBM, Connect button). The Intel
session is assigned to the second session tab.

Switching between sessions

Switch between sessions by clicking on the session tab for the session or by selecting the open
session number from the View menu. The sample below has four sessions connected: IBM, Intel,
Sony and Microsoft. "Intel" is the active session.

J | 1w P\ 1B Ikl A5 Microsolt _Setsion 5 b Sestion b 4 | | Ly

Disconnecting a session

You can disconnect a session by either selecting Disconnect from the Host menu or by clicking on the
Disconnect button on the toolbar. The TCP/IP connection is disconnected, but the session tab remains
available and the remote tree and list panes remain displayed.

Reconnecting a session

A session which is in disconnected state may be reconnected either by selecting Reconnect from the
Host menu or by clicking on the Reconnect button on the toolbar.

Closing a session

A session is closed by selecting Close from the Host menu. The close command disconnects the
session (if it is connected) and clears the session tab.

2.4  Entering Your License Code

SDI FTP is distributed as an evaluation version for a 30 day trial. The evaluation version includes all
the product features. If you want to continue to run SDI FTP after the 30-day evaluation period has
expired, you must purchase a license from SDI.

When you purchase a license, you will receive a license code from SDI. Entering the license code will
change your copy of SDI FTP from an evaluation version to a licensed version and activate the
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features you licensed. To enter the license code:

Start SDI FTP.
2.  Open the Help menu and click on About SDI FTP...

Help Topics

about sDIFTR...

3. If the About SDI FTP Evaluation Version dialog box appears, click on the License Code button.
If the About SDI FTP dialog box appears, click on the License... button.

4. Inthe Product License dialog box, fill in the Licensed to and License code edit boxes. Both the
Licensed to and License code fields are case sensitive. A portion of the licensed to name is
encrypted into the license code, so both fields must be entered correctly for the license code to
work. Click the OK button.

SDIFTP - Product License

Lucensed bo:
S0l

License code:
MEZA-2GAI-PAZSATY

(a4 Cancel

Error Messages:

The license code is not valid for this release.
The 'Licensed to' file is incorrect.
The 'License code' field is incorrect.

Selecting Files

Before you can transfer files and/or folders you need to select the file and/or folders (items) you want
to transfer. You can select items using the keyboard or the mouse. Items are selected in the local or
remote list pane.

The following table summarizes the selection process. For further information read the detailed
descriptions below.

Selection type Mouse Keyboard

Single item Click on item Up or down arrow key

Consecutive items Click on first item Up or down arrow key to the first item
Shift + click on last item Shift + up or down arrow key to last item
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Non-consecutive items Ctrl + click on each item Ctrl + up or down arrow key to position
Ctrl + Space bar to select

Using the Mouse to Select Items

Select a Single Item

To select a single file or folder, left click on the file or folder in the list pane. The selected file or folder
is highlighted.

Select Consecutive ltems

To select consecutive files and/or folders, click the first item, press and hold down the Shift key, and
then click the last item. All items from the first item to the last item are highlighted.

Select Non-consecutive Iltems

To select non-consecutive files and/or folders, press and hold down the Ctrl key, and click on each
item you want to select. Each item you click on is highlighted.

Using the Keyboard to Select Items

Select a Single Item

To select a single file or folder, tab to the local or remote list pane. Use the up and down arrow keys on
the keyboard to move from item to item. A single file or folder is selected each time you press the
arrow key.

Select Consecutive Items

To select consecutive files and/or folders, use the up or down arrow key on the keyboard to move to
the first item, press and hold down the Shift key, and use the up or down arrow key to select files. To
turn selection off release the Shift key.

Select Non-consecutive ltems

To select non-consecutive files and/or folders, press and hold down the Ctrl key, use the up and down
arrow keys to move to the desired items and press the Space bar to select an item.

2.6  Transferring Files

When a session is connected to a remote host, files can be transferred in one of two directions. They
can be "downloaded" from the remote host computer to your computer. Or, they can be "uploaded"
from your computer to the remote host computer.

Downloading Files

1. Select the files or folders you wish to download from the remote host by highlighting them in the
Remote List pane.

2. Ensure the download options are set correctly for the transfer.
3. Select Download from the Action menu or click the download button ¥ on the toolbar.

Uploading Files

1. Select the files or folders you wish to upload to the remote host by highlighting them in the Local
List pane.

2. Ensure the upload options are set correctly for the transfer.
3. Select Upload from the Action menu or click on the upload button T on the toolbar.

Drag and Drop

You can also "drag" selected files from the Remote File List pane to the Local File List pane and
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3.1

vice-versa.

1. Select the files or folders you wish to transfer by highlighting them in the Local or Remote List
Pane.

2. Holding the left mouse button down, drag the files to the location in the Local or Remote List Pane
where you want the files to be transferred. You can drag files to a sub-folder in the destination list
pane.

3. Release the left mouse key to start the transfer.

See also:

Selecting Files
Using Quiet Queue Mode

How to...

Connecting to a Host Computer

1. Open the Host menu and select the Connect command or click the Connect button # | on the
toolbar.

gl Edit  Ackion  Yiew Help
Mew kel

|
B zave Chrl45

Conneck
€3 Disconneck

Reconnect

Close

Properties Al

El Run Script

2. Select a previously saved session or fill in the Connect to Host dialog box.

Conmect to Host - SDI FTP

Session Name
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Dicwndosad. com

Electionic Asls
e
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Local Host

Micsterenil

P33
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501 'wieb Siba

wilisw b

SEC

|Sony

T RO
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3. Click Connect button.
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Tips:

You may connect up to 10 sessions. See Working with Sessions for more information.

See Also:

Connecting for the First Time

3.2  Running SDI FTP from the Command Line

SDI FTP can be run from a windows command prompt. This allows you to run FTP operations from a
batch (.bat) file or to schedule file transfers with the Windows Scheduler. The FTP.EXE program
provides the command line interface. FTP.EXE runs SDI FTP in background.

The following command line parameters are available.

/Session session_name specifies the session to connect. Where session_name is the SDI FTP
session name. If session_name contains embedded spaces, it must
be enclosed in double quotes. For example:

/Session "SDI Web Site"

/Localdir folder_name specifies the name of the default local folder. Where folder_name is
the local folder. If folder_name contains embedded spaces, it must be
enclosed in double quotes. For example:

/Localdir "c:\FTP Files"

/Script script_name specifies a script to run after the session specified in "/Session" is
connected. Where script_name is the name of the script. If script_name
contains embedded spaces, it must be enclosed in double quotes.
For example:

/Script "Sample Script.txt"

The following example illustrates how this facility may be used. Assume that you want to download a
file called "data.txt". Assume the SDI FTP session name for connecting to this host is FTP1.

You will need two files to complete the operation. A batch file (Sample.bat) and a script file
(sample.txt). They both can be created with notepad.

rem Sample.bat

rem This is the batch file that starts ftp.exe, the command line interface
"C:\Program Files\SDI\\ftp.exe" /Session FTP1 /Script sample.txt

* sample.txt

* This is the SDI FTP script that contains the script commands to transfer the file.
* The "/Script sample.txt" parameter in the sample.bat file runs this script.

get data.txt

exit 0

Running Sample.bat at the command line prompt performs the file transfer without the SDI FTP
window being displayed. This is a simple example. You could add logic to the batch file and start other
programs to perform operations on the downloaded files(s). You could add logic to the script to upload
or download other files or manipulate remote or local folders.
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3.3

Scheduling File Transfers

You can use SDI FTP with the Windows Scheduler to schedule the transfer of files and/or folders on a
regular basis. This can be a powerful tool if you need to transfer files on a daily or weekly basis.
Scheduling file transfers eliminates the need to start them manually.

You will need to write an SDI FTP script with the upload or download instructions and then schedule a
task to call the SDI FTP command line interface in the Windows Scheduler.
Here are step by step instructions.

1.

3.

Write a script that performs the file transfer. See the Get and Put script commands for sample
scripts.

Test your script using the SDI FTP command line interface. For example, if your session name is
Test Session, the local folder that you are transferring files from or to is C: and the script is
called upload.txt, open a command prompt and enter:

"c:\program files\sdi\\ftp.exe" /session "Test Session" /Localdir c: /script upload.txt

| Command Prompt

progran Filesssdisedi FepsbinSFtp.exe" ssession "Test Session®™ Alocaldir
pt upload.txt

Once your script is working, you can use the Windows Scheduler to schedule it to run
periodically.

Scheduling Your Script on Windows 7, 8 10, or 11

1.

Start the Windows Vista Task Scheduler. (Start, All Programs, Accessories, System tools, Task
Scheduler, Under Actions click on the Create Task link.)

In the Create Task dialog's General tab, fill in the desired name, description, and security
settings.

In the Create Task dialog's Trigger tab, click on the New.. button to display the New Trigger
dialog. Specify when your script should run.

In the Create Task dialog's Actions tab, click on the New.. button to display the New Action
dialog. Click the Browse... button and select ftp.exe. (The default folder is c:\program files\sdi\\.)
Add the /session /localdir and /script switches in the Add Arguments (optional) edit box: /session
"Test Session" /Localdir c: /script upload.txt.

In the Create Task dialog's Actions tab, specify the conditions that allow the task to run.
In the Create Task dialog's Settings tab, specify the settings for task behavior.
Click the OK button to schedule the task.

Scheduling Your Script on Windows XP and 2000.

1.

Start the Windows Scheduler "Scheduled Task Wizard."

Windows XP (Start, All Programs, Accessories, System tools, Scheduled Tasks,
double-click Add Scheduled Task)
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Windows 2000 (Start, Programs, Accessories, System tools, Scheduled Tasks
double-click Add Scheduled Task)

B Seheduled Tada B
Pls Edt fm Fgoriee Tooks Advaoe e -
" e Folders |1 ]
2] bt Vs w G
B s Stwdds  MeafnTes  LithoTne | S
ik ke 1ok
Ditherr Flaces R ;\ -H'""--.__\_\__\_\__\_\-
:} wrdred P e " - -
T B | 2dd scheduled Task
5 Puared Documrs
[= [T erTm————— 2B ¥

When you get to the "Click the program you want Windows to run" prompt, click the Browse...

button to display the Select Program to Schedule dialog box and select ftp.exe. (The default
folder is c:\program files\sdi\\.)

Sedact Pregram 1o S hedubs

My btk Fil s

Paacss

Filaa of fupas Pregramn

3.  When you get to the "You have successfully scheduled the following task: ftp" dialog box, check
the "Open advanced properties for this task when | click Finish" check box and click the Finish
button.

Wi b a0 ettty atPamiued e bl Laid
g Open advanced properties far thiz task when | click
g [ CPX
f_-f Finizh. i
fi I:l:;;g\ha-\.n]:lm:l.lﬂr'::l'vﬁrﬂl'.l.l______——_________
cBech [ Frwh | [ o |
4,

In the ftp dialog box, add the /session /localdir and /script switches in the Run edit box.

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.




15 SDI FTP User Guide
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5. Click the OK button. Your task in now scheduled and should appear in the Scheduled Tasks

dialog box.
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3.4 Using Quiet Queued Mode

Normally when files are transferred the Copy Files dialog box is displayed giving the current status of
the file transfer and estimated time remaining. No other work can be done in SDI FTP until the file
transfer completes.

e

Copy Filas

A

Saving VisionT ouch hgx
foom Soonsumen’

INENEEER

Elapzed: Qmin T3ec (301KE copied)
Estimated time left: 22 pec
Dowmdoad to: C:h

Transfer iate; 71.EBKE/Sec

[ Conce )

If the option to transfer in quiet, queued mode is selected on the appropriate Upload or Download
Properties page, the progress dialog is not shown. Instead, the files are queued for transfer in the
background, allowing the user to continue working with other sessions. The cursor in the session
switches to the pointer + hourglass cursor indicating that a queue mode transfer is active. To view the
current status of queued transfers, select Queues from the View menu.

You may want to use Quit Queue Mode if you have large file transfers to do from different FTP sites.
For example, assume you wanted to download a large fix from Microsoft and a large software file from
Download.com. Also assume that you are using a dial-up connection. If you start the Microsoft file

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.



How to... 16

4.1
41.1

4.1.2

transfer in Quiet Queued Mode you can switch to you Download.com session and start another file
transfer. If you are not in Quiet Queued Mode you will have to wait until the download from Microsoft
completed before you could start the download from Download.com.

Menus

Host Menu

Command Summary

The Host menu contains the following commands:

New Create a new session.

Save Save your session settings.

Save As... Save your session settings with a new name. By using the "Save
As..." command you can use an existing session as a template for a
new session.

Connect Display the Connect to Host dialog box.

Disconnect Disconnect the current session. The connection to the host computer

is terminated, but the session tab for the session remains available
for reconnection.

Reconnect Reconnect the current session. You can reconnect a session that has
been disconnected. You cannot reconnect a session that has been
closed.

Close Disconnect the current session from the host computer and then
close the current session.

Properties Display the properties (settings) for the current session.

Run Script Display the Select Script File Name dialog box. Select a script and
click the Open button to run the script.

Trace Socket Turn TCP/IP socket tracing on or off.

Session Name Select from a list of recently opened sessions.

Exit Close any open sessions and exit SDI FTP.

New

Use the New command to create a new session. The New command displays the New Session Setup
dialog box. Fill in the dialog box with the required connection information and click the Connect button
to connect your new session.

If you already have sessions defined, you may use an existing session as a template for your new
session rather than creating a new session from scratch. See the Save as command for more
information.

Shortcuts:
Standard Toolbar: m
Keyboard: Ctrl + N
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4.1.3

4.1.4

4.1.5

4.1.6

See also:

Connecting for the First Time

Save

Use the Save command to save a newly created session.
Shortcuts:

Standard Toolbar: E

Keyboard: Ctrl+S
See also:

Connecting for the First Time

Save as

Use the Save as command to save a session with a new name. This is an easy way of using an
existing session as a template for a new session. Save the existing session with a new name. Then
modify the new session to meet your needs.

Connect

Use the Connect command to connect to a another computer. The Connect command displays the
Connect to Host dialog box. You may select a session and click the Connect button to connect or you
may modify session settings.

Shortcuts:
Standard Toolbar: & |
See also:

Connecting to for the First Time
Host, Disconnect
Host, Close

Disconnect

Use the Disconnect command to disconnect a session. The TCP/IP connection is disconnected, but
the session tab remains available and the remote tree and list panes remain displayed.

You can quickly reconnect the session using the Host, Reconnect command or you can initiate a file
transfer and SDI FTP will automatically reconnect the session.

Use the Disconnect command when you plan to return to your session. If you are done with the
session, use the Host, Close command and the session will be disconnected and its session tab and
remote tree and list panes cleared.
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4.1.7

4.1.8

4.1.9

4.1.10

Shortcuts:
Standard Toolbar: "
See also:

Host, Reconnect
Host, Close

Reconnect

Use the Reconnect command to reconnect a session that has been disconnected, but not closed.
Shortcuts:

Standard Toolbar: s&r
See also:

Host, Disconnect
Host, Close

Close

Use the Close command to disconnect a session and clear the session tab. When the session tab is
cleared, that tab becomes available for use by another session. The remote tree pane and remote list
pane are also cleared.

See also:

Host, Disconnect

Properties
Use the Properties command to display the session settings for the currently active session.

Shortcuts:
Keyboard: Alt + enter

Run Script

Use the Run Script command to run an SDI FTP script.

SDI FTP scripts are text files created in notepad or another text editor. Use scripts to automate file
transfer operations that you perform over and over again.

Shortcuts:
Standard Toolbar: E]!

See also:

Script Language Syntax Definition
Script Command Summary
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4.1.11 Trace Socket

Use this diagnostic command to trace socket activity. Normally you will not use this command unless
requested to do so by SDI technical support.

Do the following if you wish to capture a socket trace:

1. Start SDI FTP

2. Start the trace.
e Open the SDI FTP Host menu and click on Trace Socket.

= !

E Il Irace Socket

¢ In the Select Trace File Name dialog box, specify a name for the trace file and note the folder

that it is in.
=
zdiftp.tro .
Y -

3. Connect to the host computer and recreate the problem.

4. Stop the trace. Open the SDI FTP Host menu and click on Trace Socket.
L | .

: Trace Socket

5. E-mail the trace file and a problem description to support@sdisw.com.

4.1.12 Session Name

Use this command to connect a recently used session. The last 10 sessions are displayed in most

recently to least recently used order on the Host menu just prior to the Exit command. Click on the
session name to connect that session.
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4.1.13 HostExit

Exit SDI FTP. If one or more sessions are connected, you will be asked to confirm that you want the

session to be closed.

4.2 Edit Menu

421 Command Summary

The Edit menu contains the following commands:

Undo
Cut

Delete
Rename
Properties
Select all files
Select All

4.2.2 Undo

Negate the effect of the last operation.

Delete the selected file(s) and/or folder(s) and moves them to the
clipboard.

Copy the selected file(s) and/or folder(s) to the clipboard.

Initiate a file transfer of the file(s) and/or folder(s) currently held on the
clipboard.

Delete the selected file(s) and/or folder(s).
Rename a file.

Display file properties.

Select all files in the current folder.

Select all files and folders in the current folder.

This command is not available yet.

423 Cut

Use the Cut command with the Paste command to move a file(s) and/or folders. For example, to move
a file from your PC to the remote host, use the following steps:

1. Inthe local list pane, select the file you wish to move.
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Open the Edit menu and select Cut.
In the remote list pane, select the folder you want to receive the file.

Open the Edit menu and select Paste.

ok~ w0 DN

The file is uploaded to the remote folder and deleted from your PC.

If you want to copy a file instead of moving the file, use the Copy command.
Shortcuts:

Standard Toolbar: &

Keyboard: Ctrl + X

Context Menu
See also:

Edit, Copy
Edit, Paste

4.2.4 Copy

Use the Copy command with the Paste command to copy a file(s) and/or folders. For example, to copy
a file from your PC to the remote host, use the following steps.

1. Inthe local list pane, select the file you wish to copy.
Open the Edit menu and select Copy.
In the remote list pane, select the folder you want to receive the file.

Open the Edit menu and select Paste.

ok~ w0 DN

The file is uploaded to the remote folder.

If you want to move a file instead of copying the file, use the Cut command.
Shortcuts:

Standard Toolbar:

Keyboard: Ctrl + C

Context Menu
See also:

Edit, Cut
Edit, Paste

425 Paste

Use the Paste command to move or copy files placed on the clipboard by the Cut or Copy commands.

Shortcuts:

Standard Toolbar:
Keyboard: Ctrl +V
Context Menu

See also:
Edit, Cut
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4.2.6

4.2.7

4.2.8

4.2.9

4.2.10

Edit, Copy

Delete

Use the delete command to delete the selected file(s) and/or folders. To use the delete command,
select the file or folder you want to delete in the local list pane or the remote list pane. Open the Edit
menu and select Delete. For files on your PC, a delete operation moves the file(s) and/or folder(s) to
the Windows Recycle bin.

Shortcuts:
Standard Toolbar: X
Keyboard: Del

Context Menu

Rename

Use the Rename command to rename a local or remote file or folder. For example, to rename
sample.txt to example.txt use the following steps:

Select sample.txt.

Open the Edit menu and select Rename.

An edit box appears around the selected file.

P w NP

Type the new name into the edit box and press enter.
Shortcuts:

Context Menu

Properties

Use the Properties command to display file properties. The Properties command displays the
Windows File Properties dialog box for local files and the SDI FTP File Properties dialog box for
remote files. The SDI FTP File Properties dialog box includes the file size, location and permissions.

Shortcuts:

Context Menu

Select all files

Use the Select all files command to select all the files in the current folder of the local or remote list
pane. Use this command when you want to select all the files in a folder to perform an upload or
download operation. This command does not select files in the subfolders of the current folder.

See also:
Edit, Select All

Select All

Use the Select All files command to select all the files and folders in the current folder of the local or
remote list pane. Use this command when you want to select all the files and folders in a folder to
perform an upload or download operation.
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See also:
Edit, Select all files

4.3 Action Menu

4.3.1 Command Summary

The Action menu contains the following commands:

Download Download the files and/or folders selected in the remote list pane to
your PC.

Upload Upload the files and/or folders selected in the local list pane to the
remote host.

Set Transfer Mode Set the transfer mode for the current session.

Toggle PASV mode Turn PASV (passive) mode on or off.

Command Send an FTP command directly to the host computer.

Run Open the selected application or file.

View View the selected file(s) using the viewing application.

Stop Cancel the current file transfer operation.

Change Folder Switch to a new folder without navigating through the directory tree.

New Folder Create a new folder in the currently selected folder in the list pane.

4.3.2 Download

Use the Download command to download files and/or folders selected in the remote list pane. The files
are copied from the remote host into the current folder on your PC.

Shortcuts:
Standard Toolbar: L
Keyboard: Ctrl+ D
See also:

Action, Upload
Action, Set transfer mode

4.3.3 Upload
Ese the Upload command to upload files and/or folders selected in the local list pane to the remote
ost.
Shortcuts:
Standard Toolbar: ]
Keyboard: Ctrl+ U
See also:
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Action, Download
Action, Set transfer mode

4.3.4 Set transfer mode

Use the Set transfer mode command to set the file transfer mode. The following modes are available:

Automatic Selects binary or ASCII mode based on the file type of the file. If the file type is listed
in the ASCII mode file extensions list, the transfer is made in ASCII (text) mode
otherwise the transfer is made in binary mode.

Binary Transfers files in binary mode. Use this mode for non-text files like images,
applications (.exe), and word processing files.

Text Transfers files in ASCIl mode. Use this mode for text-only files. This mode converts
the line-feed characters that appear at the end of lines in text files to allow for the
differences in format between different operating systems when uploading or
downloading files.

Shortcuts:
Standard Toolbar: 'E'
Context Menu

4.3.5 Toggle Passive (PASV) mode

Use the Toggle Passive (PASV) mode command to change from Active mode to Passive mode or
Passive mode to Active mode.
The FTP protocol uses two ports, a control port and a data port.

In active mode the client initiates the connection to the server control port and the server initiates the
connection to the client data port.

In passive mode (PASV) the client initiates the connection to both the control port and the data port.
Active mode

command port : client to server
data port: server to client

Passive mode
command port: client to server
data port: client to server

The proper mode depends upon firewall and FTP servers settings. If active mode fails, try your
connection in passive mode.

Shortcuts:
Standard Toolbar: ¥

4.3.6 Command
Use the Command command to send an FTP command directly to the server. The command is sent
verbatim without any interpretation. A one line response is expected. Use this command if the FTP
server supports custom commands not available in SDI FTP.

When you click this command, the Send Command dialog box is displayed. Enter your command in
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the command edit box and click the OK button to send the command. The command edit box contains
a drop-down list of recently used commands for easy access to previously issued commands.
Shortcuts:
Standard Toolbar: |
4.3.7 Run
Use the Run command to open the selected application(s) or file(s). When the selected file is a remote
file, the file is downloaded to the SDI FTP temporary folder and then opened.
If the file is an application, the application is executed. If the file is a data file, it is opened with the
associated application. For example, a ".doc" file is opened with Microsoft Word.
Shortcuts:
Standard Toolbar: i
Context Menu
4.3.8 View
Use the View command to open the selected file(s) in the Windows Notepad application. When the
selected file is a remote file, the file is downloaded to the SDI FTP temporary folder and then opened.
Shortcuts:
Standard Toolbar: L
Keyboard enter
Context Menu
4.3.9 Stop
Use the Stop command to stop a file transfer that is in progress. The stop command is only needed
with the "Use quiet, queued mode" option set for the upload or download. When the "Use quiet queued
mode" option is not set, an active file transfer must be cancelled used the Cancel button in the Copy
Files dialog box.
Shortcuts:
Standard Toolbar: (X
Keyboard escape
4.3.10 Change folder

Use the Change Folder command to switch to a new folder without navigating through the directory
tree. The change folder command displays the Change Folder dialog box. Enter the new path into the
Change Folder dialog box and click the OK button.

The remote path must be relative to the FTP root folder. For example:

\folder\subfolder

The local path must be the full qualified path. For example:
c:\folder\subfolder
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4.3.11 New folder

4.4
4.4.1

4.4.2

4.4.3

Use the New Folder command to create a new folder in the current folder. The New Folder command
creates a folder named "New Folder" (local list pane) or "Folder" (remote list pane) and opens an edit
box around it. Type the desired name and press Enter to complete the folder creation.

Shortcuts:
Standard Toolbar: C¥

Context Menu

View Menu

Command Summary

The View menu contains the following commands:

Output Log Show or hide the output log window.
Status Bar Show or hide the status bar.
Toolbar Show or hide the toolbar.
Arrange Icons Arrange entries in the local or remote list pane.
Large Icons Display the entries in the local or remote list pane in large icon format.
Small Icons Display the entries in the local or remote list pane in small icon
format.
List Display the entries in the local or remote list pane in list format.
Detail Display the entries in the local or remote list pane in detail format.
Refresh Refresh the contents of the currently selected pane.
Log Files Show the log files in the log files folder.
Queues Show the current status of file transfer queues.
Synchronize Synchronize local and remote folders.
Preferences Change application behavior.
Session Change the view to another active session.
Output Log

Use the Output Log command to show or hide the output log pane.

The Output Log pane shows the FTP commands and responses to and from the host computer for the
currently active session. Each line appears in a different color as follows:

Green FTP commands sent to the remote host

Blue Normal responses and messages received from the remote host

Red Error messages received from the remote host

Black Status or informational messages generated by SDI FTP
Status Bar

Use the Status Bar command to show or hide the status bar.
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Mezzage Restart PaSY Tranzfer Bytes
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Ready Restart PASY .ﬁ.u'tr-:u 1619
The status bar contains the following fields.
Field Description
Message area This area contains messages to help you use SDI FTP.
Restart indicator Displays "Restart" when the host supports FTP file restart.
PASV This field displays "PASV" when the session is in passive mode and is
blank when the session is in active mode.
Transfer Mode Displays "Auto", "Binary" or "Text" indicating the current file transfer
mode.
Byes transferred Displays the number of bytes transferred by the last file transfer
operation.
4.4.4 Toolbar

Use the Toolbar command to show or hide the toolbar. Use the toolbar for quick access to commonly
used commands.

D] 2| |#£]E] %8

[ x| $ft]elt] @V |Dck &%=

Customize

You can customize the toolbar. Right click on the toolbar to display the Customize Toolbar dialog box.
Use the Customize Toolbar dialog box to add, remove or reorder the toolbar buttons.

Button Summary

m New Create a new session.
E Save Save your session settings.
£ | Connect Display the Connect to Host dialog box.
<3| Disconnect Disconnect the current session.
<7+ Reconnect Reconnect the current session.
[E4 Run Script Run a script.
& Cut Delete the selected file(s) and/or folder(s) and move them to
the clipboard.
Copy Copy the selected file(s) and/or folder(s) to the clipboard.
Paste Initiate a file transfer of the file(s) and/or folder(s) currently
held on the clipboard.
Delete Delete the selected file(s) and/or folder(s).
Download Download the files and/or folders selected in the remote list
pane to your PC.
Upload Upload the files and/or folders selected in the local list pane
to the remote host.
View View the selected file(s) in the viewing application.
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4.4.5

4.4.6

4.4.7

i | Command Use this dialog to send an FTP command directly to the host
’ computer.

£ Run Open the selected application or file.

[@¢ Set Transfer Mode  Set the transfer mode for the current session.

% | Toggle PASV mode Turn PASV (passive) mode on or off.

& Stop Cancel the current file transfer operation.

#| New Folder Create a new folder in the currently selected folder in the list

pane.

[ Refresh Refresh the contents of the currently selected pane.

Log Files Show the log files in the log files folder.

=s Synchronize Synchronize local and remote folders.

Arrange Icons

Use the Arrange Icons command to sort entries in the local or remote list pane by name, origin (for the
Recycle bin), size, type or date, in ascending or descending order.

This command is only available when a list pane has focus and the command only affects the list pane
with focus. For example, if the local list pane has focus, only the items in the local list pane are sorted.
The remote list pane remains unchanged.

When the list pane is in detail view, you can sort by the column entries by clicking the column heading.
See Also:

Windows and Panes

Large Icons

Use the Large Icons command to change the local or remote list pane to the large icon view. The large
icon view shows a large icon and the file or folder name.

This command is only available when a list pane has focus and the command only affects the list pane
with focus. For example, if the local list pane has focus, only the items in the local list pane are
changed to the large icon view. The remote list pane remains unchanged.

See Also:

Windows and Panes

Small Icons

Use the Small Icons command to change the local or remote list pane to the small icon view. The
small icon view displays a small icon and the file or folder name.

This command is only available when a list pane has focus and the command only affects the list pane
with focus. For example, if the local list pane has focus, only the items in the local list pane are
changed to the small icon view. The remote list pane remains unchanged.

See Also:

Windows and Panes
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4.4.8

4.4.9

4.4.10

List

Use the List command to change the local or remote list pane to the list view. The list view displays a
small icon and the file or folder name. Items are displayed in vertical columns.

This command is only available when a list pane has focus and the command only affects the list pane
with focus. For example, if the local list pane has focus, only the items in the local list pane are
changed to the list view. The remote list pane remains unchanged.

See Also:

Windows and Panes

Detail

Use the Detail command to change the local or remote list pane to the detail view. The detail view
displays the following fields.

Name The file or folder icon and name.

Size The file size. (Not displayed for folders)

Type The file type. ("File Folder" is displayed for folders.)
Modified The date the file or folder was last modified.

This command is only available when a list pane has focus and the command only affects the list pane
with focus. For example, if the local list pane has focus, only the items in the local list pane are
changed to the detail view. The remote list pane remains unchanged.

Columns is the detail view may be resized by hovering the mouse over the column heading separator
and dragging it to make the column larger or smaller.

See Also:

Windows and Panes

Refresh

Use the Refresh command to refresh a the remote list pane after file manipulation.
Set the Automatic refresh option to automatically refresh the remote list pane any time it is updated.

(Host, Properties, Options tab, "Automatic refresh" check box) or
(Host, Connect, Advanced... button, Options tab, "Automatic refresh" check box).

Automatic refresh IF_r

Shortcuts:
Standard Toolbar: @
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Keyboard: F5

remote

4.4.11 Log Files

Use the Log Files command to see a list of your log files. The log files contain everything that appears
in the output log pane. A separate log file is created for each session. The log file is closed when the
session is closed.

The Log Files command displays the Log Files dialog box. The buttons in the Log Files dialog box
perform as follows:

Open Open the selected log file(s) in Notepad.
Delete Delete the selected log file(s).

Delete All Delete all the log files.

Close Close the Log Files dialog box.

Select a single log file from the list box by clicking on it. Select consecutive files from the list box by
clicking the first file, pressing and holding down Shift key, and then clicking the last file.
Select non-consecutive files by pressing and holding down the Ctrl key and clicking on each file.

Shortcuts:
Standard Toolbar: g
Keyboard: F5

4.4.12 Queues

Use the Queues command to view the file transfer queue. File transfer operations are placed in a
gueue and run in background when the "Use quiet, queued mode" option is set on. The "Use quiet,
gueued mode" option may be set on for uploads and/or downloads. See the Upload tab or the
Download tab in the session Properties (Host, Properties) or Session Setup (Host, Connect,
Advanced button) dialog boxes.

The Queues command displays the Queues dialog box. The Queues dialog box lists the number of
files in the queue for each session.

4.4.13 Synchronize

Use the Synchronize command to display the Compare / Synchronize pane for a session. From this
pane you can compare and synchronize a local folder with a remote folder. This powerful tool allows
you to quickly and easily move new or updated files from your PC to a remote site or vice versa.

For example, if you are maintaining a web site and have made numerous changes on your PC and
want to upload the changed files to your web hosting site, the Synchronize feature will determine what
files have been updated and upload them for you.

Synchronize Pane Settings

Compare / Synchronize Direction

Compare / Synchronize remote folder to local folder (upload) - Use this option to update a
remote folder with files from a folder on your PC.

Compare / Synchronize local folder to remote folder (download) - Use this option to update a
folder on your PC with files from a remote folder.
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4.4.14

Compare remote and local folders (upload and download) - Use this option to update both the
folder on your PC and the remote folder.

Local Folder
Remote Folder

Options

Include sub-folders

Ignore case

Transfer smaller files

Transfer larger files
Transfer older files

Transfer more recent files

Buttons

Compare

Synchronize

Cancel

Shortcuts:
Standard Toolbar:

Preferences

The current local folder. This is the folder on your PC that will be used
for the compare and/or synchronize operation.

The current remote folder. This is the remote folder that will be used
for the compare and/or synchronize operation.

Check this option to include subfolders of the local folder and remote
folder in the compare and/or synchronize operation.

Check this option to treat file or folder names that are spelled the
same, but in different case as equal. For example, "SDI" would be
treated as equal to "sdi" and "Sdi".

Check this option to have smaller files replace larger files.

Check this option to have larger files replace smaller files.
Check this option to have older files replace new files.

Check this option to have newer files replace older files.

Click the Compare button to compare the local and remote folder.
Using the option specified, compare lists all the changes required to
synchronize the local and remote folders. Review the results of the
compare operation prior to clicking the synchronize button to make
the updates.

Click the Synchronize button to transfer the files and folder listed by
the compare operation.

Click the Cancel button Return to the standard view without
transferring any files.

=

Use the Preferences command to change program behavior. The Preferences command displays the
Program Options dialog box. You will find the following settings.

General Tab

E-mail address

The e-mail address is used to fill in the password field for anonymous
connections. For example, if you open the Host menu and select N
ew, then click in the Anonymous check box, the User Name edit box
is set to "anonymous" and the Password edit box is filled in with the
e-mail address from this field.

Show Connect Dialog at Startup Checked this box to display the Connect to Host dialog box at

startup. This allows you to select a session and click the Connect
button to connect the session. If you have one or more sessions with
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the Connect at startup option set (Host, Connect, Advance button,
Host tab, Connect at startup), you may not want the Connect to Host
dialog box to appear at startup.

Show Standard Toolbar  Check this box to display the standard toolbar. Click the Customize
button to display the Customize Toolbar dialog box and modify the
contents of the toolbar.

"View" Application Specify the application for file viewing. This application is called when
you specify the View command in the Action menu or the file context
menu. The default application is notepad.exe. To select a different
application, click the ... button and locate the new application.

File Types Tab

ASCII mode file extensions: The ASCII mode file extensions are used when the file transfer
mode is set to Automatic. (Action, Set transfer mode, Automatic).
Files with the extensions in this list are transferred in text mode. All
other files are transferred in binary mode. New entries can be added
by typing the file extension in the edit box and clicking the Add button.
To delete an entry, highlight it in the list box and click the Remove
button. To reset the list to the default setting, click the Defaults

button.
Folders Tab
Log Files: Specify a folder for storing log files.
Queues: Specify the folder for storing file transfer queues.
Script Files: Specify the folder for script files.
Session Profiles: Specify the folder for storing session profiles.
Temporary Files: Specify the folder for storing temporary files.

4.4.15 Session

Use this command to select a session to display. All active sessions are listed at the bottom of the
View menu. The currently displayed session is preceded by a check mark. Click another session name
to display the other session.

45 Help Menu

45.1 Command Summary

The Help menu contains the following commands:

Help Topics Display the Table of Contents for this help file.
About SDI FTP... Display the version number and build date of the application and

current licensing information.

4.5.2 Help Topics

Use the Help Topics command to displays the table of contents for the help file. This command also
gives you access to the help index and the help find function.
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4.5.3

4.6
4.6.1

About SDI FTP...

Use the About SDI FTP ... command to display the version number and build date of the application
and the current licensing information.

Click the License... button to display or modify your license code.

See Also:

Entering Your License Code

Context Menu

Context Menu Command

Summary

The SDI FTP context menu offers access to commonly used commands. Right-click on a file or folder

in one of the tree or list panes to
menu. File or folder specific com
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The context menu contains the following commands.

View
Run

Download

Upload

View the selected file in the viewing application.
Open the selected application or file.

Download the files or folder selected in the remote list pane to your
PC.

Upload the file or folder selected in the local list pane to the remote
host.

Transfers files in binary mode. Use this mode for non-text files like
images, applications (.exe), and word processing files.

Transfers files in ASCIl mode. Use this mode for text-only files. This
mode converts the line-feed characters that appear at the end of lines
in text files to allow for the differences in format between different
operating systems when uploading or downloading files.

Delete the selected file or folder and moves it to the clipboard.

Copy the selected file or folder to the clipboard.
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Paste Initiate a file transfer of the file or folder currently held on the
clipboard.

Delete Delete the selected file(s) and/or folder(s).

Rename Rename a file.

Properties Display file properties.

New Folder Create a new folder in the currently selected folder in the list pane.

5 Reference

5.1 Scripts
5.1.1 Script Language Syntax Definition

The syntax descriptions of the script commands use the following notational conventions:

Magenta colored words are replaced by user input.
Blue colored symbols are part of the syntax definition and are not included in the command.
The following symbols are part of the command and should be entered exactly as they appear in
the command format:
colon

" double quotation marks

Square brackets [ ] indicate an optional parameter and are not included in the command.

5. Braces {} are used with the vertical bar | to indicate choices between two or more mutually
exclusive items and are not included in the command.

6. Words starting in column one and beginning with a colon : are labels. Label names are case
sensitive.

7. Lines starting with an asterisk * in column one are treated as comments.
Each line in a script file contains a command in the following format:
command [parameterl [parameter2 parameter3,...parametern]] comment

The command indicates the function to perform and the parameter(s) provide the data needed for the
function. Anything following white space after the last parameter on each line is a comment.

The command is not case sensitive, so it may appear in any combination of upper and lower case. Any
blanks or tabs between the command and the first parameter are ignored.

Comment lines can be added to script file by placing an asterisk (*) in column one. For example:

*

* These three lines are comments

*

SDI FTP Copyright © 2003-2025 by SDI. All rights reserved.



35 SDI FTP User Guide

5.1.2 Script Command Summary

The following is a list of script commands.

Command Description

! Issue a command in the Windows environment.

? Display a list of valid script commands.

ASCII Set ASCII (text) mode for file transfer.

Auto Set automatic mode for file transfer.

Binary Set binary mode for file transfer.

Cd Change the current folder on the remote computer.

Close Close the current session.

Delete Delete a file on the remote computer.

Dir Display the contents of the current folder on the remote computer.

Disconnect Disconnect from the remote computer.

Exit Exit from SDI FTP.

Get Download a file from the remote computer.

Goto Jump to a label in the script file.

Help Display help information on script commands.

If Evaluate a condition and execute a script command if true.

Lcd Change the current folder on the local computer.

Literal Send a command to the remote computer.

Ls List the contents of the current folder on the remote computer.

Mkdir Create a new folder on the remote computer.

Put Upload a local file to the remote computer.

Quit Close t_he current session and exit the application if no other sessions
are active.

Rename Rename a file or folder on the remote computer.

Rmdir Delete a folder on the remote computer.

Set Set prompts on or off for delete and replace operations.

5.2 Keyboard Shortcuts

Although operating SDI FTP is considerably easier with a mouse, all the normal functions can be
carried out using a standard keyboard.

Function Keyboard Shortcut
Copy Ctrl+c

Create a new session Ctrl +n

Cut Ctrl + x

Display session settings Ctrl + enter

Download file Ctrl +d

Paste Ctrl +v

Save a session Ctrl +s
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6.1
6.1.1

6.1.2

Select consecutive files Alt + Up or Down arrows
Select non-consecutive files Ctrl + Up or Down arrow. Press the Space bar to select a file

Switch panes Tab or Backtab
Stop upload or download  Esc
Upload file Ctrl +u

FAQ (Frequently Asked Questions)

This section contains frequently asked questions and answers. SDI also maintains an FAQ page on
our web site that may have updates that were created after this help file was published, so if you do
not find the answer to your question here please check the following web site page:

http://www.sdisw.com/ftp/fag.htm

Connection Problems

Error: could not locate host

This message is normally caused by one of the following:

1.

You are not connected to the Internet. You must make your connection to the internet before
using SDI FTP to connect to a host computer. If you are an America Online (AOL) user, you must
connect to AOL and login before trying to connect using SDI FTP.

If the IP address in the message is incorrect, then you have the wrong "Host Name:" in the SDI
FTP Connect to Host dialog box.

There is a problem on the Internet and currently there is no route to the host computer. Try again
later.

You have the incorrect port number specified in the Connect to Host dialog box.
The domain name in the Connect to Host dialog box could not be translated to an IP address.

If you are using WinGate to share a modem between computers, you must specify the WinGate
IP address (normally, 192.168.0.1) in the "Host Name:" edit box in the SDI FTP "Connect to Host"
dialog instead of the host computer IP address or name.

Error: failed to connect

This error is caused by one of the following:

1. You are attempting to connect to an Internet host address and your computer is not
connected to the Internet.

2. You have the incorrect IP address or domain name specified in Host Name edit box in the
Connect to Host dialog box.

3. You have the incorrect port number specified in the Connect to Host dialog box.

4. The FTP server at the host site is down.

Try pinging the host computer to see if it is responding. You can do this from the MS-DOS command
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6.2
6.2.1

6.2.2

6.2.3

prompt by entering "ping hostname" or "ping IP address" on the command line. If Ping times out, there
is a problem at the host. Talk to a network administrator at the host site and see if they can help you.

License Code Problems

The 'Licensed to' field is incorrect

The name in the "Licensed to" name does not match the name encrypted into the license code. The
“Licensed to" hame is incorrect or contains a typographical error.

The "Licensed to" name is case sensitive make sure all letters are in the correct case.
Make sure the "Licensed to" name has the correct number of spaces.

The "Licensed to" name and license code are issued in pairs. The "Licensed to" name must
correspond to the license code you received.

The 'License code' field is incorrect

The 'License code' files contains a typographical error. Make sure the license code is all in upper case
and that all the characters are correct.

The license code is not valid for this release

The license code you entered is for an older release of SDI FTP.
The license code is generated for a specific release and will not function with newer releases of SDI
FTP. (How else could we get you to pay for upgrades?)

The product release level is three digits separated by periods, for example, 2.3.0. The license code
only checks the first two digits, so a license code created for 2.3.0 will work with releases 2.3.1 through
2.3.9. However, if you try to use it with release 2.4.0 or higher you will get the above error message.

If you have purchased a maintenance contract, upgrades are free. Send an e-mail to
sales@sdisw.com with your current "licensed to" name and the new SDI FTP release level and you will
be e-mailed a license code for the new release.

If you do not have a maintenance contract, you may purchase an upgrade or you may download the
release level that works with your license code. Product downloads can be found on the Customer

Downloads page of our web site.
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